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Question Shuffling Allowed : Yes

Question Number : 1 Question Id : 8801791737 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

If a CD can store 650 megabyte of data, then how many mebibyte of data can the same CD store?
Options:

1. % 5158333

= # B12E5E

3. % B17.111

4. ¥ £19.888

Question Number : 1 Question Id : 8801791737 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
ot T HIET 650 AETET 20T FER F Thd T €, a7 20T T radT ftanse Uw o ST @ # awd T 27

Options:

1. % 618333
Z % B13Z.555
3. % B17.111
4 ¥ B19. 228

Question Number : 2 Question Id : 8801791738 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
The P and memory are located on the:

Options:

1. ¥ motherboard

2. ® expansion board
2. % storage device

4. # putput device

Question Number : 2 Question Id : 8801791738 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
HIUT 31T HANT ®ET 0 6T 87
Options:

1. ¢ g

= R goaiig g

2 ® i fEaEd

4 % arIeqe ZaEd

Question Number : 3 Question Id : 8801791739 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Graphics card is an interface to the computer's motherboard using which connector?

Options:
1. ¥ PCI Express
2. % HDMI

3. % DVI



4 % 1ISE

Question Number : 3 Question Id : 8801791739 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
TTherd 12 HTALT o Aoals o 1ol U SO & AT o Friered T S0 & T5T 57

Options:

1. % PCI T
2. % HDMI

3 % DVl

4. % USE

Question Number : 4 Question Id : 8801791740 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Howr to display or hide the formatting of a selected text in the Outline view?

Note: For this question, discrepancy is found in question/answer. Full Marks is being awarded to all
candidates.

Options:

1. 5lash kew or nurmeric keypad

2. 5lash kev on alphabetic keypad

=. 5lash key on both nurmeric and alphabetic kevpad

4 ALT + TAE

Question Number : 4 Question Id : 8801791740 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
TR T3 H T TS o WIS Bl e Wi =T fouTar =my?

Note: For this question, discrepancy is found in question/answer. Full Marksis being awarded to all
candidates.

Options:

1. HEATAE SIS O Toldl Frail

2. ArhTdied hide U Rl &

3. HEATCH® ST SeBlaldd hids ai-l UL ol &

4. ALT + TAE

Question Number : 5 Question Id : 8801791741 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

To move the insertion poinit to the Address box, or to highlight the URL in the Address box, what neads to be
done from the following?

Options:

1. % CTREL + 5

2. % ALT + A
3.V ALT +D

4 % SHIFT + TAE

Question Number : 5 Question Id : 8801791741 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
AT Teig 1 Uod arad H of oI & o, o7 02 aiad § URL &1 5Ieese 9t & o] R Teirad # & a7 @ $1 aasdaddT o7

Options:



1. % CTEL + 5
2. % ALT + A
3V ALT +D
4. % SHIFT + TAE

Question Number : 6 Question Id : 8801791742 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
In a kevboard, the Arrow kevs, Home key, End key, Pagellp key, PageDown keys are knowt as:

Options:

1. ® Standard keys

= % Function keys

2. ¥ MNavigation keys

4. % Special purpose keys

Question Number : 6 Question Id : 8801791742 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

gmh‘ HEZ ﬂi%gﬁ (Arrow) T, BIF (Hormne) 3il, T8 (End) F=i, 0= (Fagelp) 31, TasT24 (PageDowr) F=1 &1 T e
ST AT &7

Options:

1. % = g

2. % g gt

3. ¢ AT g

4. % TErag TR g

Question Number : 7 Question Id : 8801791743 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
A magnetic ______ 15 a device used to read rragnetic stripe cards, such as credit cards,

Options:

1. ¥ card reader

2 % mernory circuit

2. ® Memory COnnector

4. % magnetic chip

Question Number : 7 Question Id : 8801791743 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

e c A o U & R S s UET e w uge ¥ iy R e 2, S dfee @
Options:

1. ¢ F12 Tt

2. ® TONT Ak

2 % OO g

4 & OONT R

Question Number : 8 Question Id : 8801791744 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
& business card reader 15 a device used to 5can and electronically sawve printed

Options:



1. * Ethernet card
2. % internet card
3. % graphics card

4 % business card

Question Number : 8 Question Id : 8801791744 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
e Teeie W12 11T U JUa & e S0 Fard o Selg w0 & giogd

Options:

1. % SomT wE
2 ¥ ST wE
3. % Tiithad w1
4. T aE

T eI o ol fefar T 1

Question Number : 9 Question Id : 8801791745 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
The card-to-reader cormmunications is performed on the basis of following standard:

Options:

1. % 150 7800
2. ¥ [50 7816
3. % 150 7008

4. % [50 786

Question Number : 9 Question Id : 8801791745 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
FIE-7- 11T 9o g AT
Options:

1. % 150 7300

= ¥ 150 7816

3. ® (50 7006

4. % [530 786

Question Number : 10 Question Id : 8801791746 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
A webhCam is a video carmera that its irmage in real tirme o or through a Corrputer 1o a Cornputer network,

Options:
1. ¥ feeds

2. % feedbacks
3. % processes

4 % transforms

Question Number : 10 Question Id : 8801791746 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
e clel SPHET U TSl AT & AT ared (e QA< | AT H0E] oF ATedd # ®eged Heder U 0T g

Options:



1. v g

2 % giage
3. % gl
4, % wOET

Question Number : 11 Question Id : 8801791747 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
which of the following is a presentation graphics software package?

Options:

1. * M3 Windows
= % M3 PowerFoint
3. % MS Excel

4. % M3 Word

Question Number : 11 Question Id : 8801791747 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

FeraferTee o & T W TTTthere wiitreae BT 27
Options:

1. % MS Windows

2. ¥ WS PowerPoint

3. % M3 Excel

4 % M5 Word

Question Number : 12 Question Id : 8801791748 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
which of the following is NOT a new feature in Windows Vista?

Options:

1. ® Agro Shake

= ¥ Windows Paint
3. * Aero Snap

4. % pero Peek

Question Number : 12 Question Id : 8801791748 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
Torg #f @ ey T T T 3 e € e = 27

Options:

1. % T

2. ¥ T2 (wWindows) T
z ¥ wrEy

4 % (RT O

Question Number : 13 Question Id : 8801791749 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
In MS PowerPoint 2016, which of the following views shows thumbnail versions of all the slides and COrganises
them in horizcntal rows?

Options:



1. * HMormal View
2. % Outline View
= % Slide Sorter View

4. # DMNotes Page View

Question Number : 13 Question Id : 8801791749 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

M5 P%?werPc:-int 2016 # fgieiEd gt # & w1 q7 Gl T1es o el-el SR B [T § o 3w A uimat # saaiedd
TAT B

Options:

1. % Sma =g

2. ® HTITAEA =,
3. ¢ TAES AT =
4 % JEFUT ]

Question Number : 14 Question Id : 8801791750 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
which of the following is a power-saving state in Windows 77

Options:

1. % Log Off
2. ¥ Sleep
3. % Restart

4. % Lock

Question Number : 14 Question Id : 8801791750 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

Windows 7 H, FEERET § 8 B -2 R ey
Options:

1. % Log Off

= ¥ Sleep

3. ® Restart

4 % Lock

Question Number : 15 Question Id : 8801791751 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
What will be the output for the function ISMNA(L) in OpenOffice Calc?

Options:
1. ¥ TRUE
2. ¥ FALSE
3. %1
4. %0

Question Number : 15 Question Id : 8801791751 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
OpenCffice Calc HISMA(L) thera 3 AT amaeye =1 gimm?

Options:



1. ¥ |9 (TRUE)
2. ¥ e (FALSE)
3% 1

4. %0

Question Number : 16 Question Id : 8801791752 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Wwhich graphics file format DOESH'T support to change the background of Desktop?

Options:

1. % jpg

= % png
3. ¥ docx
4. # dib

Question Number : 16 Question Id : 8801791752 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

I AT T 56 HTET S 10 2l U/ 1 aae o ol a0 F51 #edT a7
Options:

1. % jpg

2. % png

3. ¥ docx

4 % dib

Question Number : 17 Question Id : 8801791753 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
What i3 the kevboard shortcut to lock the screen?

Options:

1. % Window Key + O
=z % Window Key + 3
2. ¥ window Key + L
4. % Window Key + M

Question Number : 17 Question Id : 8801791753 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

T AT de o ol diaie JTede 4T 57
Options:

1. % Window Key + O

2. % Wwindow Key + 5
2. ¥ Window Key + L
4. ® window Key + M

Question Number : 18 Question Id : 8801791754 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
The is that bar that runs across the bottorm of the Windows screen.

Options:



1. * Title bar
2. % Taskbar
= % Toolbar

4 % Menu bar

Question Number : 18 Question Id : 8801791754 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
5 AN & AT Windows T & i H2ied 5T 8l

Options:

1. * Title bar

= ¥ Taskbar

3. % Toolbar

4. % Menu bar

Question Number : 19 Question Id : 8801791755 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
What is the default location of taskbar on screen in Windows operating systerm?

Options:

1. % Bottom portion of screen
2. % Left portion of screen

3. % Upper portion of screen

4. % Top portion of screen

Question Number : 19 Question Id : 8801791755 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
T AT T e # T 9 W Tewa & 2 ee T 47 27

Options:

1. & wh1T @ H @ fgear
> % e g e
3 ® Wi o s e
4. % wEhid o o e

Question Number : 20 Question Id : 8801791756 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
PSlZportisa ______ [LITL COTTeCtor.
Options:
1. % 4
2 %5
.Y

4 % 7

Question Number : 20 Question Id : 8801791756 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
P52 O T Flaree Bl

Options:



1. % 4
o % g
v 6
4 % 7

Question Number : 21 Question Id : 8801791757 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
when Testing should be stopped?

Options:

1. % Wwhen times run out

2. % when manager ask to stop

3. ¥ It depends upon the risk associated with project

4. % Wwhen encugh money is spent on testing

Question Number : 21 Question Id : 8801791757 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

T T el &g, F AT ATE0?

Options:

1. ¥ Fg AF Faa AT

2. % e B T o Ty

3. g Ui § 2 e 0 e T g

4, % T LI O UATA U7 E T AET e

Question Number : 22 Question Id : 8801791758 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Eoundary value analysis belongs to:

Options:

1. ¥ Elack box testing
2. % Wwhite box testing
% % Systern testing
4. % Unit testing

Question Number : 22 Question Id : 8801791758 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
AT T T R wet g 27
Options:

1. =0 ST T

2. % cETET AT gl

3. % UITET gelEoT

4 & gepTs w0

Question Number : 23 Question Id : 8801791759 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Zost of software testing is

Options:

of software developrment.



1. % 70-380%
2. ¥ 20 - 40%
3. % 40 - 50%
4. % 7 -10%

Question Number : 23 Question Id : 8801791759 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
HATFIIT TEIG0T 1 AT AIFea Y el &

Options:

1. % 70-320%
= ¥ 20 - 40%
3. % 40 -50%
4 % 7-10%

Question Number : 24 Question Id : 8801791760 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
Testing technicqueals) that can be used in acceptance testing is | are:

Options:

1. * structural
2. ® functional
3. % usahility

4. % both structural and functional

Question Number : 24 Question Id : 8801791760 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
______ T TAT T e Tl g O T50T H JUT Te2 =T a2l

Options:

1. % T=THT

2. ® Fraica®

3. % gaeg

4 & XA A Sica® gl

Question Number : 25 Question Id : 8801791761 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
which of the following is MNOT true about the black box tester?

Options:

1. # Is highly motivated to find faults

2. ® [z creative to find the systermn weakness

2. ¥ Should be able to understand the source code

4. % Should be able understand a functional specification or requirements docurment

Question Number : 25 Question Id : 8801791761 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
TRTeET # 9 B et d19d T & a1 § TR AR 87

Options:



1. % g ¥ o arcatas ifa 3

2. % 1Ty o FH= B 0T A & T EEHE

3. ¢ T HIE T GHS H T FET T

4. % g wraicaw S a7 smasamaret & SeaTe @1 gAsH § 98 5T aTiey

Question Number : 26 Question Id : 8801791762 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
which of the following file formats is used for font file?

Options:
1. % ff
= % fnf
3.¥ fnt
4. % font

Question Number : 26 Question Id : 8801791762 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
TT-e WIEA o (ol =g # & fore g e 0Te &7 JuiT foaT a1 27

Options:
1. % ff
2 % fnf
3. ¥ it

4 % font

Question Number : 27 Question Id : 8801791763 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
LZH file is used for which file?

Options:

1. % Image colour matching profile file
= ¥ Compressed archive file

3 % andio file

4. % VRML file

Question Number : 27 Question Id : 8801791763 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
LZH WTEa &7 IUT fofe w1ge o foig o =T 27

Options:
1. % i a7 e e e

=, ¥ giiiET 9oy wEa
3. ¥ aizgimEd
4 ® YRML ®EdA

Question Number : 28 Question Id : 8801791764 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
15 a cormputer networl: that helps to connect a small area @ building).

Options:



1. ¥ LAN
2. % MAN
3. % WAN
4. % SAN

Question Number : 28 Question Id : 8801791764 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
______ AT T et & ST BIE | 8 (SART) T @-ae 31 § Ao 3947 8l

Options:

1. ¥ LAN
= % MAN
3. % WAN
4. % SAN

Question Number : 29 Question Id : 8801791765 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

If wou wish to connect | communicate your computer (source) to another cornputer (destination), then which of
the following is the correct prompt cormrmand?

Options:

1. *® Initialize

Z. ¥ Ping

3. % Connect

4. ® Send | Receive

Question Number : 29 Question Id : 8801791765 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

AT ST 30 HET () T T o Soee (e § e | 9ol 92T 154 &, a1 (g # § $19 971 FHS U FAIS 51 57
Options:

1. % sidemES

2 o T

z & gdgT

4 % dz | Tl

Question Number : 30 Question Id : 8801791766 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
is the part of the network that has cormmon address component.

Options:
1. % Subnet

2. % Subset
= * Sybclass

4. % Sub-device

Question Number : 30 Question Id : 8801791766 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

______ I T & TEEET & EH S U2 W 0w T 8l

Options:



1. T
= % gauw
S ® gy

4 ® ga-iZaned

Question Number : 31 Question Id : 8801791767 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
There carn be many ways to insert a page nurmber in a M5 Word 2016 docurment.

which of the following lets vou insert page mumber?
Options:

1. % Page number from Insert menu

2. % Page Setup from File Menu

3. % Footnote from Insert menu

4. % Page number from Design menu

Question Number : 31 Question Id : 8801791767 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
T M5 Word STagHT U HEaT 5-a¢ F4-1 F B8 qL00 51 G 8l

TRTETRET B & 1 A7 AT U 6] 5oale @i § g laaT #<dT a7
Options:

1. 5| B # U |

2. ® HIEH B H U dea

3. % g U Jedle

4 % TS O O HEaT

Question Number : 32 Question Id : 8801791768 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
& page brealo in M5 Word 15 used to:

Options:

1. % create a new page at the insertion point

2. ® create a new page at the bottorm of the docurment
3. % create a new page that cannot be deleted

4. % create a blank page at the top of the document

Question Number : 32 Question Id : 8801791768 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
M5 Word B U U s & W TR T ST AT 87

Options:

1. ¢ zewd Telg o g =41 gg a1 o ey

2. % ZEATe o Terer AT H# U@ 9T UF a4 & oy
Z. % gw AT UE &9 F o, T g ARt A1 "
4. % ZEarEr o S oY U el OF a3 e

Question Number : 33 Question Id : 8801791769 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical



Correct Marks: 1 WrongMarks: 0
What 15 the key combination to display a shortCut rmmenu’

Options:

1. % SHIFT + F&
= % SHIFT + F&
3. % SHIFT + F10
4. % SHIFT + F11

Question Number : 33 Question Id : 8801791769 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

sfféere e Wi @t o Torg gt artor o 27
Options:

1. % SHIFT + F&

2. % SHIFT + F9

3. % SHIFT + F10

4. % SHIFT + F11

Question Number : 34 Question Id : 8801791770 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Dirop cap function is available in which tab of M5 Word 20077

Options:

1. # Layout
= ® View
3. ¥ Insert

4. % Format

Question Number : 34 Question Id : 8801791770 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
ETT &7 Hered M5 Word 2007 & 59 2 § I0deer 57

Options:

1. % wemae
2 %=

3 ¥ g
4 % qiHT

Question Number : 35 Question Id : 8801791771 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

What is the margin of a page when narrow option is selected for top and bottorm while printing a docurnent in
M5 Word 20107

Options:

1.% 1cm, 1cm

2 % 1cm, Scm

3.9 127cm, 127 cm

4 % 1cm, 1.25c0m

Question Number : 35 Question Id : 8801791771 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical



Correct Marks: 1 WrongMarks: 0

M5 Word 2010 ¥ U SEdTde & TUTs #id THd Ud AHF F & SUE 1T A1 & T Hekiel [deed @7 oree ed @0 g8 &1
ATRA & BT &7

Options:

1. % 1 Hamiey, 1 HemEe

o % 1 ginftey, 5 doHET

3. ¥ 127 "Wy, 1.27 HemiEe
4, % 1 gimeEy, 1.25 demEe

Question Number : 36 Question Id : 8801791772 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Identify the checkbox option under AutoCorrect tab which is NOT in M5 Excel.

Options:

1. % Capitalize first letter of sentences
2. ® Capitalize names of days

3. ¥ Capitalize first letter of table cells

4. # Correct accidental use of CAPS LOCK

Question Number : 36 Question Id : 8801791772 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

fTel e 3 F ST 39 TGP dwed hl Ug=l & AT MS Excel § 781 21
Options:

1. % gyt 3 ugel STy B =T (BT AT

2 ® T @ AW w FeT (Fiiee T

=, & TITeiRT il 3 Uge YT R G (RTHee) WA

4, % CAPS LOCK o Tied I & TR meri &7 At Far

Question Number : 37 Question Id : 8801791773 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Arrange the following steps to Capitalise the whole text.

a) ©n the Home takb, in the Font group, click Change Case (Aa).
b Select the text for which you want to change the case.

<) Click on the option.

d) Choose Upper case option.

Options:

1.¥badc

2 % boacd

2 ¥ phdac

4 % b, c,d a

Question Number : 37 Question Id : 8801791773 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
¢ ST B a2T (FTUCATSH) T o (o] 9 =0T & e @)

2) §1W 3d WY, HT-¢ GHg H, & daef (4a) W fFeem #4
b} I SET T o TIEeRT W S0 Sge] SR gl

c) oo . Toemr @

o) S0 e Terehe



Options:
1. b adc

2 % bhoacd
2 ®¥pdac
4 #* hcoda

Question Number : 38 Question Id : 8801791774 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
view i3 the default view in MS Excel.

Options:
1. ¥ work

oo% Ao
= % Normal
4. % Romar

Question Number : 38 Question Id : 8801791774 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
M3 Excel #igwlrs goa ______ T
Options:

1. % o

2 ® amr

= ¢ HH

4 ® O

Question Number : 39 Question Id : 8801791775 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
which of the following features in M5 PowerPoint should wou use when typing in the notes text box?

Note: For this question, discrepancy is found in question/answer. Full Marks is being awarded to all
candidates.

Options:

1. Slide show

2 Insert

3 Mew

4. 00T

Question Number : 39 Question Id : 8801791775 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
MS PowerPoint H, dee S1e # 2150 @i @ [oll] T Ficre (rom) 7 JU=IT R <aT 87

Note: For this question, discrepancy isfound in question/answer. Full Marksis being awarded to all
candidates.

Options:

1. &S at

2 EH

3

4 W

Question Number : 40 Question Id : 8801791776 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical



Correct Marks: 1 WrongMarks: 0

Ir1 M5 PoweerPoint 2007, ______ 15 a special effect that determines how a slide appears as it enters or leaves the
SCIRET.

Options:

1. ¥ transitions
= % printings
3. % animations

4. % hand outs

Question Number : 40 Question Id : 8801791776 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
______ M5 PowerPoint 2007 T 0w 06T wTd & =11 95 i #war ¢ 7o $1 T5e T 0% ol o7 =i 90 e s o

Options:

1. & it
o % i
3. % g

4. % gz raed

Question Number : 41 Question Id : 8801791777 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Toinclude a text Do i M5 Excel, use the tal:

Options:

1. ® Data
= % Home
3. ¥ Insert

4. % Page Layout

Question Number : 41 Question Id : 8801791777 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
M5 Excel H U e STad AT ®e- o ToiT,

Options:

1. ® 2TT(Data)

2. % =1 (Home)

= ¥ ¢ (Insert)

4, % U9 #1313 (Page Layout)

Question Number : 42 Question Id : 8801791778 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

which of the following events is in the right order to insert an Excel chart in M5 PowerPoint presentation, so
that any changes in Excel chart are reflected in the chart inserted in PowerPoint?

Options:

1. ¥ Home > Copy chart from Excel > Paste in FowerPoint > Keep Source Formatting & Link Data
2. % Home > Copy chart from Excel > Paste in PowerPoint

3. % Home > Copy chart from Excel > Paste Special in PowerPoint

4. % Select chart > Save 45 FPT



Question Number : 42 Question Id : 8801791778 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

M5 FowerPoint WEead H e o AiFATed @t & o] FaieiEs # § @19 df oear 951 %0 # 5, 91 PowerPoint H# ST T
=TE H UFEd I H ®IE AT Oiterd 1 aieatgT g7

Options:

1. ¥ 51 » Excel @ a1 ®UT & > PowerPoint # U2 B¢ > RIT Tae00T Ud foitr 221 & -RawdT (@0 @ SR o @ 220
2. % 210 > Excel § =% & & > PowerPoint # e &t

% % 210 > Excel 9T FT & > PowerPoint H 16T T8 &4

4, ¥ g% F1 999 > WE s (PDF) & &7 H #g

Question Number : 43 Question Id : 8801791779 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

The speed of an internet service may vary, depending on the ______.
Options:

1. % type of browsed sites

2. ¥ network capacity

3. % type of user

4. # gervice provider

Question Number : 43 Question Id : 8801791779 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

T WA ______ o SITET O T 51 el 1 31
Options:

1. % T3 & TE AELT & T

= ¥ dvady gaEar

3. ® JummTeRT Al & WEE

4. ¥ HarueEr

Question Number : 44 Question Id : 8801791780 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

Information retrieval services, Web services, World Wide Web, and Cornmurnication services are types of
SErvices.

Options:

1. ¥ internet

2. % data entry
3. % knowledge
4. % intelligent

Question Number : 44 Question Id : 8801791780 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

T [AVITE HaT, o 90T, dre d158 o, o T g ______ LEIEIE R Car
Options:

1. ¢ gatT

o % Feryfaf o

3. % A

4 % ghgoe gefee



Question Number : 45 Question Id : 8801791781 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

which of the following service allows access to the information rescurce stored in Gophers servers?
Options:

1. ® File Transfer Protocol (FTF)

2. % Archie

2. ¥ VERCHMNICA

4. % Gopher

Question Number : 45 Question Id : 8801791781 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

g | & i &1 S MY (Gophers) Hee H Hg T GoeT GaT IO U5 Har @dl 57
Options:

1. ® mEd TIEE Hie @ (FTF)

2. % i (archie)

3. ¥ eI (VERONICA)

4, % ML (Gopher)

Question Number : 46 Question Id : 8801791782 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

which of the following is a web service that offers a way t0 access docurments spread over the internet?
Options:

1. % world wide Web

2. % Video conferencing

3. ®% FTP

4 * Telnet

Question Number : 46 Question Id : 8801791782 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

g | & I T STeT Hell § ST Sete UY Sl TEqTerAT qf Ugail T O TE0T Hal ®ed| 57
Options:

1.9 g2 aEs oo

3. ® FTP

4 ® TT

Question Number : 47 Question Id : 8801791783 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

If you live in a rural area that CANNOT access cable or DSL Internet services, then
benefit you most.

COTINeCtion ey

Options:

1. * fiber optic service
2. ¥ satellite

3. % ADSL

4. # 5DSL



Question Number : 47 Question Id : 8801791783 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

%ﬁw?mmﬁ@%aﬁmmDSmeﬁuﬁaﬂﬁﬁ ______ eI ST ToIT Here SfTErer wTeRTer
LET

Options:

1. ® mEay Ale® |@ar
2. ¥ IuE (AeesT)

3. % ADSL

4 % SDSL

Question Number : 48 Question Id : 8801791784 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
File Transfer Protocol (FTF) and Archie are the examples of:

Options:

1. % web services

= ¥ information retrieval services
3. % world Wide Web

4. # COMITUINIcation Services

Question Number : 48 Question Id : 8801791784 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
T5a CHIGC0 HiEiehie (FTF) 3% 31l (Archie) ooy # & fradr agmeor &7

Options:
1. % g dar

2. ¥ T G T
3 R g aEs da
4. ® o o

Question Number : 49 Question Id : 8801791785 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Activation of the ______ happens when it has an [P address and the embedded HTTE server 15 enabled.

Options:

1. ¥ internet service
= % internet speed
3. # internet optons

4. % network provider

Question Number : 49 Question Id : 8801791785 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
IP 7T & Ur2 s HT TP 9e¥ &F 9gH 514 0%

Options:

1. geeee |ar
2 ® FordT R
3 % oo et
4 ® Sz ngET



Question Number : 50 Question Id : 8801791786 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
which of the fOllOW‘iI‘lg 15 NOT a type of cormrmunication network, to provide cormrmunication internet servicesy

Options:

1. % Circuit-Switched Cormmrmunication MNetworl
2. % Packet-Switched Cormrnunication Network
2. ¥ Discrete-switched Communication MNetwork

4. #* Syhitrhed Corrnunication MNetwiorl

Question Number : 50 Question Id : 8801791786 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
TR et Aol & WaT @i & o] Foieiad § & $19a7 62 Jeddr &7 UF TEW T51 27

Options:

1. ® wite-Tres ar Jedw
2. % Ne-Troes v Sead
3. ¥ Eeie-Tres Tar Jead
4. ® oz TOK J2ad

Question Number : 51 Question Id : 8801791787 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Al ______ Carn retain copies of web content at various points throughout a network,

Options:

1. % Virtual Private Networlk: (VPN

2. ¥ Content Delivery Network (CDI)
3. % 5D

4 % Public MNetwiork

Question Number : 51 Question Id : 8801791787 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

______ T S 3 T Rigelt = e @it &1 wht 7 o we
Options:

1. % Sfstel WTEeT Heah (VEL)

2. i Eatait e (COM)

3. % I5SDN

4. ® Ulecrd HTad

Question Number : 52 Question Id : 8801791788 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

With ______ mail service, you can view slideshows, photos and videos right from inside your mailbosx. You can
serid up to 50 files or 100 ME file size in a single email.

Note: For this question, discrepancy isfound in question/answer. Full Marksis being awarded to all
candidates.

Options:

1. ¥Yahoo

2 GMX



=, Cutlocl.com
4. Zoho

Question Number : 52 Question Id : 8801791788 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

______ HeT #AT o T, ST S0 Ao ad H TAES ], Bl 3 Siiadr 8 T ol H U@ ¢ 5Ha H 50 B1Ed 97 100 ME T
&I TBTEA O T Bl

Note: For this question, discrepancy is found in question/answer. Full Marks is being awarded to all
candidates.

Options:
1. Yahoo
2. GME
3. Cutloolk com
4. Zoho
READING COMPREHERMSTONM
Section Id : 880179176
Section Number : 2
Section type: Online
Mandatory or Optional: Mandatory
Number of Questions: 1
Number of Questionsto be attempted: 1
Section Marks: 5
Display Number Panel: Yes
Group All Questions: No
Sub-Section Number: 1
Sub-Section 1d: 880179176
Question Shuffling Allowed : Yes

Question Id : 8801791789 Question Type: COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension

Questions: No

Question Numbers: (53t057)
Juestion Label - Comprehension



Fead the passage given below and answer the questions:

e need to preserve seeds of different floweers, vegetables, fruit and other trees for posterity. In order to do 5o
researchers have begurn storing therm in freezers called seed banks. There are some 1400 seed banks around
the world. So far, the 1055 has been particularly marked in the case of cultivars.

Crer the centuries, about 10,000 species of plants have been used as food. Many of these have a plethora of
varieties: for instance mangoes and apples alone have some 15,000 varieties,

Unfortunately this diversity is now slowly declining. The chief reason being that only a limited number of
species and their varieties are able to fetch money in global marketplace, 45 you will agree consumer tastes
keep changing. If there is no demand for a particular vegetable or fruit farmers will stop cultivating it

Crly about 150 species are still in use today. And of these four—rice, wheat, maize and potatoes -meet half
the calorie requirements of humankind. Of these four species, few varieties are in use. To prevent the resultant
1055 in biodiversity and the growing prevalence of vulnerable mono-culture, about 140 countries have agreed
to store seeds of cultivated and wild plants in gene banks.

To retain the viability of the seeds, they are dried and then frozen at a temperature of -20%C.

But even such seeds cannot 1last indefinitely. Peas and pulses die within few yvears; grain seeds within a few
decades. Therefore, these stocks have to be carefully thawed at regular intervals, rehydrated and replanted to
gain fresh seed stocks which are again frozen.

Should wars or natural disaster wipe out several such archives in one stroke and irretrievably destroy seed
stocks, the gene banks of wild plants and cultivars, have been provided a kind of re-insurance. Many of the
seed banks maintain a duplicate set of agricultural crop seeds in the econormically -run Svalbard Global Seed
Vault in Spitshergen, Morway.

Sub questions

Question Number : 53 Question Id : 8801791790 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
The passage talks about the importance of

Options:
1. * cultivars

for future use.

2. ¥ storing seeds
2. % insuring plants

4. % recycling plants

Question Number : 54 Question Id : 8801791791 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
which of the processes given below is correct?

The seeds are:

Options:

1. * frozen — rehydrated — replanted — thawed — dried — stored
2. % stored — rehvdrated — replanted — thawed — dried — frozen
2 % dried — rehvdrated — replanted — stored — frozen — thawed

4. % dried — frozen — thawed — rehydrated — replanted — stored

Question Number : 55 Question Id : 8801791792 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Eesearchers feel the need to store seeds of certain plants so as to:

Options:
1. #* cultivate at a later date
2. % retain viability of seeds

3. % preserve bio-diversity



4 % create a gene bank

Question Number : 56 Question Id : 8801791793 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
Seeds stored in banks are re-insurad b

Options:

1. * recycling them periodically

2. % maintaining duplicate sets of seads

2. % keeping thermn in econormically run seed vaults

4. ® keeping thern at subzero temperatures

Question Number : 57 Question Id : 8801791794 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
seeds can be stored in gene banks:

Options:
1. ¢ for few years

2. % for few months
= % for hundreds of vears

4. *% for a very short time

Question Id : 8801791789 Question Type: COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions: No

Question Numbers: (53t057)
Juestion Label - Comprehension
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Sub questions

Question Number : 53 Question Id : 8801791790 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
g T ey o Jum ey ___ o Agcd & a H &1 FaT 5l

Options:



1. % FEclad (cultivars)
2. ¢ S HER

% % otert @ S AT FAT
4. % eyt & TETEiEaT

Question Number : 54 Question Id : 8801791791 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
e &1 e uidrst # & w19 9t uidar w8t 8

EIEIETs
Options:
1. % mFd — 0 gEgee — I 3T — TedET — a1 — H2R &
2 % IR AT — I §EEes — YA INHET — TWeamT — F@ET — Wi
3. % gEEI — U FEges — YA ST — 2 &A1 — W — e
4 gEHr — B — UaAEr — 9 55808 — I ST — HER FT

Question Number : 55 Question Id : 8801791792 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
STerRa ialt 1 g Ul & a1 1 T P B s o B UEEA Gid T gl

Options:

1. % q & qrer f 4t 3

2. % S T SOeg T T T B
3. ¥ Sg-TdTEET ® ST w5
4 % Fq¥F I

Question Number : 56 Question Id : 8801791793 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
T et O wUe T ot T &

Options:

1. % T - THT W S TS el o ZRT

2. o & & Ziterhe | & gRT

3. % gy THaat &0 6 oo 16l & alele | H T @
4 R I 30 I TIHEH W T B

Question Number : 57 Question Id : 8801791794 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Tt T % Toy i sfent # SO T 7 ST 21

Options:

1.« gw ot

2. % g weH!

3 % dmct gl
4. % ggd & gHT

QUANTITATIVE AFTITULE
Section 1d : 880179177



Section Number : 3

Section type: Online

Mandatory or Optional: Mandatory

Number of Questions: 6

Number of Questionsto be attempted: 6

Section Marks: 6

Display Number Panel: Yes

Group All Questions: No
Sub-Section Number: 1
Sub-Section 1d: 880179177
Question Shuffling Allowed : Yes

Question Number : 58 Question Id : 8801791795 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
Study the following information carefully and answer the question given below.

AT urm contains & red, 4 blue, 2 green and 3 vellow marbles.

If three marbles are picked at randcorr, what is the probability that two are blue and one is yellow??
Options:
3

;% 91

i
¥
L =

18
5 « 455

7
L % 15

Question Number : 58 Question Id : 8801791795 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

TrafeRET AET ®T e d areae @ oY el T T 04 &7 3¢ )
T TS H 6 AT, 4 A6, 2 5% 3% 3 Uit Area 3

At ATl €0 § T ATl o A1 5, T1 56 a1 i a1 gaeadr g o g et § #f1e g die g7
Options:
3

1 % 91

[
¥
| =



18
5 v 455

7
L, % 15

Question Number : 59 Question Id : 8801791796 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

The ratio of present ages of Jyoti and Ankita is 7 5. If after six vears, their ages will be in the ratic of 4 : 3,
what would be the present age of Ankita?

Options:
1. % 32
2. % 36
3% 30
4 % 35

Question Number : 59 Question Id : 8801791796 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

ﬁﬁﬁmfﬁaﬁwmmm?ﬁ%aﬁmaﬁfaﬂeﬁqu 3 o SR O SIT, a1 SrfT d ad A e
Options:

1. % 32

2. % 36

3% 30

4 % 35

Question Number : 60 Question Id : 8801791797 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
what approximate value will come in place of the gquestion mark ) in the following question? (You are NOT
expected to calculate the exact valug)

7% 0f 801 -231.17 =7 - 23%of 789
Options:

1.9 430

2. % 440

2. % 540

4 % 520

Question Number : 60 Question Id : 8801791797 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
T v § ARy (7) % S U SgATHT Hod T ST (A0 G [ UhaH 951 Ted i SUeT T8 o

E7%of B01 - 22117 =7 - 23% of 78S
Options:
1.9 4490

2. % 440



3% 540
4. ® 520

Question Number : 61 Question Id : 8801791798 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

The sum of five numbers is 260, The average of the first two numbers is 20 and the average of the last two
numbers is 70, What is the third number?

Options:
1. % 33
2 ¥ ED
3% 75

4. % Cannot be deterrmined

Question Number : 61 Question Id : 8801791798 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
T ST T AN 260 71 UEeT of |earst &7 off|d 30 o7 iy o awnstt &7 affad 70 31 T a7 747 57

Options:
1. % 323
= ¥ B0
3% 75
4, % Torerifeg A1 [T =T G

Question Number : 62 Question Id : 8801791799 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
what approximate value will come in place of the question mark ) in the following question? (You are not
expected to calculate the exact value)

7441 + 34 %12 =7 =323+ 110
Options:

1. % 420

=2 ¥ 280

2. % 530

4 % 350

Question Number : 62 Question Id : 8801791799 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
TEmET vg § TARg (7) % SO U SgATHT Hod T4 ST (A0 GE1F [ Uhad 951 Ord i SlUeT T8 o

7441 + 24 x12=" x93+ 110
Options:
1. % 420

2. ¥ 280
2% 540
4 % 350

Question Number : 63 Question Id : 8801791800 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0



Study the following information carefully and answer the questions given below.
& comrmnittes of five members is to be formed out of;

3 Trainees, 4 professors and 6 research associates. In how many different ways can this be done if - the
corrrnittee should hawve all 4 professors and research associate or all 2 trainees and 2 professors?

Options:
1.9 12
2. % 13
3% 24
4 % 52

Question Number : 63 Question Id : 8801791800 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

TRl T ST @7 eaTgde areaa- ®¢ 3 T B oy wet @ =
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T 3 Wiy #fIT 2 M g1 Anipy?

Options:

1.9 12

2 % 13

3% 24

4 % 52

GEMEREAL MEMNTAL ABILITY AND REEASCRING

Section Id : 880179178
Section Number : 4
Section type: Online
Mandatory or Optional: Mandatory
Number of Questions: 6
Number of Questionsto be attempted: 6
Section Marks: 6
Display Number Panel: Yes
Group All Questions: No

Sub-Section Number: 1
Sub-Section 1d: 880179178
Question Shuffling Allowed : Yes

Question Number : 64 Question Id : 8801791801 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Answer the following question based on the arrangement given below:

YW@l&CN3PLB9T=D*E2£{MVS37#4FGS5

How many such symbols are there in the above arrangement which are NOT immediately preceded by a number and
also NOT immediately followed by a letter?



Options:

1. % il

2 % Cne
2. ¥ Two
4 % Three

Question Number : 64 Question Id : 8801791801 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

A & 1 T F AR Y A=RfET gew 3o &
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Options:
1. % w95l M7l
2 % TE
3. ¥
4. % =

Question Number : 65 Question Id : 8801791802 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
which of the following words will come second if all of therm are arranged alphabetically a5 in a dictionary™?

Options:

1.9 Alive

= % Afforest
2. ® Anticipate

4. % Appreciate

Question Number : 65 Question Id : 8801791802 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

It HRTATET el @1 U Team iy & SIgaT auliqwd § sOaie o ST 2, 1 gET S U 4 7 S8 AT
Options:

1. % Alive

2. % Afforest

3. % Anticipate

4. # Appreciate

Question Number : 66 Question Id : 8801791803 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
which of the following words will come second if all of therm are arranged alphabetically a5 in a dictionary™?

Options:

1. * Amphibian
= ¥ Amorphous
2. # Amphitheatre



4. % Ambiguous

Question Number : 66 Question Id : 8801791803 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
ate; AT deal @ Ud Jegh i & SgER auliged | Saaieard o ST g, a7 a8 T 0T Hi9 &7 e, AT

Options:
1. % Amphibian
2. ¥ amorphous

2. % Amphitheatre
4. Ambiguous

Question Number : 67 Question Id : 8801791804 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

Arrange the given words in the sequence in which they ocour in the dicticnary and then choose the correct
SEQUETLCE.

1. Select

2. Seldom

=2 Send

4. Selfish

E. Saller

Options:

1. %1, 2 45 2

2. % 21,543
3.2, 1,45, 3
4 ® 2,5 41,3

Question Number : 67 Question Id : 8801791804 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
TS T STe | @1 39 @0 H OdST & Fed o fegea H 51 5 o e |51 ®H &1 oo @ed 5l

1. Select
2. Seldom
2 Send
4. Selfish
E. Saller

Options:

1.% 1,245 2
2 % 2 1,5 4 2
2. ¥ 2 1,45 2
4 % 2541, 2

Question Number : 68 Question Id : 8801791805 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

The following question consist of two words each, that have a certain relationship to each other. Followed by
four lettered pairs of words. Select the lettered pair that has the same relationship as the original pair of words.

Bee : Hiwve
Options:
1. ® Horse : Carriage



2. ¥ Cow : Byre
=. * Rider : Eicvcle
4 % Dog : Show

Question Number : 68 Question Id : 8801791805 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
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Options:

1. % =T Fie

2. & T T

3 % WA (TEEY) AT

4 ® T A

Question Number : 69 Question Id : 8801791806 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

Select the option that 1s related to the third nurnber in the same way as the second number 15 related to the
first nurmber.

1459 228 15597
Options:
1. % 1g9

2. ¥ 248
3% 261
4. ® 268

Question Number : 69 Question Id : 8801791806 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:

1. % 169

= ¥ 248

3% 261

4 % 268

GENERAL AWARFENESS

Section Id : 880179179
Section Number : 5
Section type: Online
Mandatory or Optional: Mandatory
Number of Questions; 6
Number of Questionsto be attempted: 6
Section Marks: 6

Display Number Panel: Yes



Group All Questions: No

Sub-Section Number: 1
Sub-Section Id: 880179179
Question Shuffling Allowed : Yes

Question Number : 70 Question Id : 8801791807 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0

<n 8 March 2013, President of India has released a commemorative postage stamp on late Sahir Ludhianyi at
Fashtrapati Ehawar, Ludhiarvi was:

Options:

1. * the translator of the Omar Khayyarm's Rubaivat into Hindi
Z % an eminent social activist of India

2. % one of the top urdu dramatists and actor

4. ¥ yidely acclaimed as a people’s poet

Question Number : 70 Question Id : 8801791807 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:

1. % AT ToamH & s ard ® Bal H Sgdrg s
2. % WT & UF Uit AHIE BEd]

3. % ot 3 AedeRl o st § | 0w

4. & T o Wi w H S w0 | Haee

Question Number : 71 Question Id : 8801791808 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
Where i India is the Jim Corbet National Park located?

Options:

1. % Uttarakhand

2. % Jarmrru and Kashrmir
2. # Madhva Pradesh

4. % Bihar

Question Number : 71 Question Id : 8801791808 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: 0
TR Wide J4=e UTeF AT # F51 9T 57

Options:

1. s

2 % Sy ofR W
I % mees

4 % TER

Question Number : 72 Question Id : 8801791809 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0



which of the following pairs is MOT correctly matched?
Options:

1. ®¥ Kanha Mational Park - Madhya Pradesh

2. % Sultanpur Mational Park - Haryana

3. ¥ Ranthambore National Fark - Gujarat

4. % Bandipur MNational Park - Karnataka

Question Number : 72 Question Id : 8801791809 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O

TraeET # & B AT AST G5 7 & A A51 @ar a7
Options:

1. % Hrgl T J2I - Hed e

2 ® graWyl T8 JE - FRamT

3. TR T FEI - TR

4. % T TP IUAW - FARE

Question Number : 73 Question Id : 8801791810 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
TRIF: and TRIMS are the terms associated with

Options:

1. % IMF
2 ¥ WTO
% % [BRED
4. % D4

Question Number : 73 Question Id : 8801791810 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
T (TRIPS) 3 fFT (TRIMS) Sec Torae avaied a7

Options:

1. ¥ SmETAUE (IMF)

2. ¥ ZeFgetEt (WTO)
= ® amEdtamest (BRDY
4, ® TESTT IDA)

Question Number : 74 Question Id : 8801791811 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
which of the following is NOT a core industry in India?

Options:

1. % Electricity

2 % Coal

Z. ® Petroleum Products

4 % Iron ore

Question Number : 74 Question Id : 8801791811 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0



Tt & & ®-ar v # g mgE TeiT g 87
Options:

1. % e

o % FgEr

3. ® Ugiferaw I

4. ¥ &g srew

Question Number : 75 Question Id : 8801791812 Question Type: MCQ Option Shuffling : Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 Wrong Marks: O
Wwho was responsible for the introduction of the Vernacular Press Act?

Options:

1. ¥ Lord Mayo
= % Lord Lytton
3. % Lord Ripon

4. % Lord Curzon

Question Number : 75 Question Id : 8801791812 Question Type: MCQ Option Shuffling: Yes Display Question Number : Yes
Single Line Question Option : No Option Orientation : Vertical

Correct Marks: 1 WrongMarks: 0
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Options:
1. % i Bt
o ¥ w2 e
z. ® FAE o
4 ® FE =T
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Sub-Section 1d: 880179180
Question Shuffling Allowed : No

Question Number : 76 Question Id : 8801791813 Question Type: TYPING TEST Display Question Number : Yes

Surmrmer camps are supervised camps conducted to entertain as well as equip students with various life skills
such as tearmwork, socializing, decision making, independent and responsible living and more. [t aids the
overall development of a child and children hawve fun during this process as they get to explore new arenas.
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Question Number : 77 Question Id : 8801791814 Question Type: TYPING TEST Display Question Number : Yes



Congratulations on your new job. You have put in the hard worlk it takes to get to this point and that deserves
a celebration. But, there is a lot of uncertainty that comes with a new job. You will encournter new people, a new
environment and a new set of responsibilities. To set you up for success, here are some tips o guide you
through the first weel: of your job. Introduce yourself. Studies hawve showr that anxiety in new situations can
corme in part from not feeling confident in how to introduce ourselves. It is a natural feeling that when you are
new, you do not necessarily want to call attention to yourself. But in the first days of a new job, you warnt your
enthusiasm to shine through. So, find the timing that feels right and give a quick, energetic introduction to the
people vou do not know yet. [f meeting new people is particularly important to you, you can enlist the help of
others. Mention to yvour manager that introducing yourself is a priority for you and ask for a list of people you
should get to know. [N meetings, you could ask the organizer to gZive you S0rme time at the beginning or end to
introduce yourself. Ask well-timed questions. Research has shown that new employees perform better when
they ask more questions. By asking yvour leaders and peers for new information, you will get up to speed
quickly. But in your first week, you want to find the right tirme to ask questions. Here are sorme guidelines for
how and when to aslk. Think about what you want to know, In some cases, you Ay need permission, while at
other times you may need advice or validation. If you get specific, you will be better able to ask and less likely
to waste time. Prioritize the information you need. For examples, if you cannot get your cormputer or access
badge to work, that is something vou need help with immediately. If vou are not clear on the quarterly goals
for your tearn, you can probably wait to tall with your manager about that over the coming weeks. Seel out a
friend in your office. Once you have made some introductions and have a sense of who you will be working
with, ask a fellow employee to have lunch or coffee with you. Developing a trusted relationship will make you
feel more comfortable as you are getting to know this new workplace. In fact, research has showr that having
social ties at work can make us more productive, During this first week, you may not find your best friend or
dewelop a deep relationship with anyone. But seeling out scomeone you can relate to will provide the needed
stability. Learn how to navigate and enjoy yvour new workplace. Locate the restrooms, the coffee and water, the
stairs and elevators, where vou Can eat lunch and talke breaks. Also, seek out any other armenities that your
workplace offers.
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